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Predgovor 

Tema ovog završnog rada odabrana je radi vlastitog interesa za 2D računalnom animacijom 

nakon dugogodišnjeg rada tradicionalne 2D animacije. Cilj ovog završnog rada je usavršavanje 

sposobnosti izrade 2D animacije i stjecanje novih znanja u ovom području. 

 

Zahvaljujem se mentoru doc. dr. sc. Andriji Berniku, pred. na pruženoj pomoći oko izrade rada 

ovog završnog rada. 



 

 

Sažetak 

2D animacija je proces kreiranja iluzije pokreta u dvodimenzionalnom prostoru. Tradicionalna 

2D animacija se crtala ručno, ali sada se može i računalno generirati. Računalna animacija se i 

dalje pridržava pravila i načela koja se koriste pri izradi tradicionalne animacije, ali sada mnogo 

posla obavlja računalo pomoću raznih alata. Postoji mnoštvo programa za izradu 2D animacije, 

uključujući širok izbor potpuno besplatnih i onih koji se naplaćuju. 

U ovom radu opisan je jedan besplatan program (OpenToonz) i jedan program za izradu 2D 

animacije koji se plaća (Adobe Animate). 

 

Ključne riječi: 2D, animacija, računalna animacija, OpenToonz, Adobe Animate 

 

 

Sinopsis 

 

2D animation is the process of creating the illusion of movement in two-dimensional space. 

Traditional 2D animation was drawn by hand, but now it can also be computer generated. 

Computer animation still adheres to the rules and principles used in creating traditional animation, 

but now much of the work is done by the computer using various tools. There are tons of 2D 

animation programs out there, including a wide variety of free and paid ones. 

This paper describes one free program (OpenToonz) and one paid program for creating 2D 

animation (Adobe Animate). 

 

Keywords: 2D, animation, computer animation, OpenToonz, Adobe Animate 
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1. Uvod 

Animacija, u suštini, predstavlja iluziju pokreta kroz prikaz niza statičnih slika. Ova umjetnost 

ima svoje korijene gotovo od samih početaka ljudske civilizacije, a prvi poznati primjeri animacije 

uključivali su prikaze lova na zidovima špilja, stvorene putem niza crteža. 

 

Jedna od značajnih prekretnica u povijesti animacije dogodila se s pojavom Disneyjevog prvog 

dugometražnog animiranog filma, "Snjeguljica i sedam patuljaka", što je označilo početak 

revolucije u svijetu animacije. Kasnije je film "Priča o igračkama" naglasio potencijal računalne 

animacije, potaknuo njezin napredak i postavio temelje za izradu modernih animiranih filmova. 

 

Iako se oslanja na tradicionalna načela animacije, računalna animacija danas koristi tehnološke 

alate za ubrzanje procesa. Digitalne datoteke zamijenile su papir i cel folije, a računala obavljaju 

mnoge zadatke. Animatori sada mogu koristiti softverske programe za crtanje, primjenjivati 

različite efekte i alate za manipulaciju, uključivati različite medijske elemente kao što su zvukovi 

i glazba te na kraju stvarati gotovu animaciju u video formatu. 

 

Postoji mnogo programa za izradu 2D animacije, uključujući besplatne i komercijalne opcije. 

U ovom radu razmatramo različite aspekte animacije, povijest, tradicionalnu i računalnu 2D 

animaciju te se fokusiramo na dva softverska alata, OpenToonz i Adobe Animate, kako bismo 

razumjeli njihove prednosti, nedostatke i razlike. 
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2. Animacija 

Animacija je iluzija pokreta koja se postiže izmjenjivanjem slika (eng. Frames) na kojima je 

prikazan pokret. Izmjenom slika koje su skoro identične, s malenim promjenama, u našem mozgu 

se stvara pokret zbog brzine izmjene slika. Brzina izmjene slika je veća nego što naš mozak može 

procesirati, zato ne možemo primijetiti izmjenu slika, nego vidimo jednu pomičnu sliku. [1] 

 

Djeca često vole crtati likove na rubovima svojih bilježnica. Na jednoj strani nacrtali bi lika u 

jednom položaju, a na drugoj istog lika u malo drugačijem položaju i tako dalje. Brzim listanjem 

kroz stranice izgleda kao da se lik kreće. Ovo je najjednostavniji primjer animacije. 

 

Bitan faktor animacije je brzina izmjenjivanja slika. FPS (eng. Frames per second) je oznaka 

za  broj slika ili kadrova koji se izmjenjuju u sekundi. Standard za animaciju je 24 fps-a. Ovaj 

standard potječe  još iz 1930-ih kada su se filmovi snimali na filmskoj vrpci. 24 kadrova u sekundi 

daje najrealniju brzinu trajanja radnje u stvarnosti i filmu. U početku se koristilo zbog ekonomskih 

razloga, kada se svaka slika ručno crtala olovkom, ali danas je ovo još uvijek standard jer smo 

naviknuti na ovu brzinu. Uz pomoć računala danas je mnogo jednostavnije napraviti animaciju s 

30 fps-a ili 60 fps-a, ali ova brzina je puno popularnija u video igrama (3D animaciji) nego u 2D 

animaciji. Osim toga, većina ljudi ne bi primijetila razliku između 24 i 30 fps-a u 2D animaciji 

zbog tromosti oka (Slika 1 prikazuje razliku između 24 fps-a, 30 fps-a i 60 fps-a). Prosječna 

tromost oka je 16Hz ili 16 fps-a. [1] [2] [3] [4] 

 

 

Slika 1 Razlika između 24, 30 i 60 FPS-a (izvor: https://www.youtube.com/watch?v=DcWE2ke45bw) 

 

https://www.youtube.com/watch?v=DcWE2ke45bw
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U video igrama i 3D animaciji, broj slika u sekundi obično je konzistentan, dok se u 2D 

animaciji često mijenja, a da gledatelj to uopće ne primijeti. Standard za 2D animaciju je 24 fps-

a, ali često se taj broj prepolovi, što znači da se svaki drugi kadar ponavlja, čime se dobiva 12 fps-

a. Ovisno o efektu koji želimo postići, taj broj može pasti na 8 fps-a ili čak 6 fps-a. [2] 

24 kadra u sekundi najčešće se koristi kada želimo prikazati brzu i detaljnu radnju. Što više 

slika imamo u sekundi, to brže izgleda radnja koja se odvija. Najpopularniji broj kadrova za običnu 

radnju je dvanaest. Još uvijek daje glatki prijelaz, a puno je brže napraviti 12 kadrova u sekundi 

nego 24. Animacija gdje jedna slika traje kao tri slike ili 8 fps-a postala je popularna u anime 

filmovima. U anime filmovima se često koristila zbog niskog budžeta, ali je korisna i za spore 

radnje. 6 kadrova u sekundi ili manje od toga ne daje toliko glatki izgled radnji i tipičan je za starije 

animacije, što animaciji daje starinski izgled.  

Veći broj fps-a ne znači bolju animaciju. Sve ovisi o izgledu koji želite postići i vašem ukusu. 

Također, u tu odluku ulazi i vrijeme i novac koji imate na raspolaganju. Tipično je u 2D animaciji 

koristiti mješavinu ovih fps-ova kako biste dobili najbolji izgled animacije uz što manje crteža. [5] 

[6] 

2.1. Kratka povijest animacije 

Animacija je u svojoj srži najjednostavnije objašnjena kao pokret prikazan kroz statične slike. 

Kao takva, postoji skoro od kako postoje ljudi. Prva takva animacija bila je prikaz lova u špiljama 

nacrtan kroz mnoštvo crteža. [7] 

 

Prije animiranih filmova kakve poznajemo danas, ljudi su izmislili razne uređaje pomoću kojih 

su gledali pokret stvoren pomoću statičnih slika. Prvi takav izum nastao je u 17. stoljeću kao oblik 

zabave i senzacija na putujućim predstavama. "Magic lantern" koristio je zrcalo na stražnjoj strani 

izvora svjetla (najčešće svijeće) kako bi usmjeravao svjetlo na staklene pločice koje su projektirale 

sliku. Više pločica stvaralo je pokretnu sliku ili animaciju.  

Prvi komercijalno uspješan uređaj za gledanje animacije bio je fenakistoskop koji je izumio 

Belgijanac Joseph Plateau 1833. godine. Fenakistoskop je funkcionirao tako da se rotiraju oslikani 

kartonski diskovi koji su se odražavali u zrcalima, stvarajući iluziju pokreta. Mogao ga je koristiti 

samo jedan gledatelj istovremeno. [8] [9] 

 

1834. godine nastao je nasljednik fenakistoskopa, to jest zoetrop. To je rotirajući bubanj 

obložen nizom sekvencijalnih slika koje su se mogle mijenjati (Slika 2). Bubanj je sadržavao 

nekoliko proreza kroz koje se gledao pokret, kako bi se izbjeglo zamagljivanje. [8] [9] 
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Slika 2 Zoetrop (izvor: 

https://www.kettererkunst.de/kunst/kd/details.php?obnr=411600168&anummer=430) 

 

Kinetograf je mala knjižica koja je uvedena 1860-ih i njezin naziv dolazi iz latinskog i znači 

„pokretna slika“, a popularno se još zove i „FlipBook“. U toj knjižici na svakoj stranici prikazan 

je malo drugačiji pokret, i kada se ona brzo listala, nastala bi animacija. [9] 

Francuz Émile Reynaud je 1877. godine kreirao praksinoskop, nasljednika zoetropa. Uske 

proreze kroz koje se na zoetropu gledala animacija zamijenila su unutarnja ogledala koja su bila 

postavljena pod određenim kutom. Ta ogledala su pružala su jasniji prikaz pokreta nego prorezi. 

Reynaud je ovaj princip prilagodio tako da se može projicirati pred publikom (Slika 3), slično kao 

film u kinu, te je postao prvi pravi poduzetnik u području animacije. [8] [9] 

 

 

Slika 3 Praksinoskop (izvor: https://standartsinema.wordpress.com/tag/praksinoskop/) 

 

https://www.kettererkunst.de/kunst/kd/details.php?obnr=411600168&anummer=430
https://standartsinema.wordpress.com/tag/praksinoskop/
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1892. godine Émile Reynaud stvorio je film "Pauvre Pierrot", koji se prema nekima smatra 

prvim animiranim filmom (Slika 4). Sastojao se od 500 ručno oslikanih pojedinačnih slika na 

duljem kolutu za praksinoskop, što je omogućilo dulje trajanje filma (skoro 5 minuta). [9] 

 

 

Slika 4 Pauvre Pierrot (izvor: https://www.dailymotion.com/video/x74s909) 

 

Povjesničari filma smatraju da je prvi pravi animirani film "Fantasmagorie" Émilea Cohla iz 

1908. godine (Slika 5). To je bio prvi film napravljen tradicionalnim tehnikama animacije. 

Neki drugi smatraju da je film "Humorous Phases of Funny Faces" (1906.) britansko-

američkog producenta J. Stuarta Blacktona prvi animirani film (Slika 6). Korištenjem stop-motion 

animacije prikazan je niz likova koji mijenjaju pokrete. Snimljen je na standardnom filmu, što ga 

čini prvim takvim. [9] 

 

 

Slika 5 Fantasmagorie (izvor: 

https://drgrobsanimationreview.com/2019/04/03/fan

tasmagorie/) 

 

 

Slika 6 Humorous Phases of Funny Faces 

(izvor:https://publicdomainreview.org/collectio

n/humorous-phases-of-funny-faces-1906/) 

 

 

 

https://www.dailymotion.com/video/x74s909
https://drgrobsanimationreview.com/2019/04/03/fantasmagorie/
https://drgrobsanimationreview.com/2019/04/03/fantasmagorie/
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Otvaranjem malog studija u Los Angelesu tijekom 20. stoljeća, riječ animacija dobiva novi 

sinonim - Walt Disney. Mnogi prvo pomisle na Disneyjeve animirane filmove kad se spomene 

riječ animacija. Disneyjev studio je svojim inovativnim i značajnim radovima postavio standarde 

i pravila za cijelu industriju animacije. 

Najprepoznatljiviji Disneyev lik, Mickey Mouse, nastao je na temelju Oswalda, Sretnog zeca, 

za kojeg je Disney izgubio prava u sporu dok je radio za Laugh-O-gram Films u Kansas Cityju, 

Missouri. Nakon toga je Oswalda modificirao, promijenivši mu uši, i tako je nastao Mickey 

Mouse. 

Mickeyev treći film, "Steamboat Willie" (Slika 7) iz 1928. godine, bio je revolucionarni 

animirani film jer je sadržavao zvuk, što je animaciju učinilo živahnijom i potpunijom. [7] [8] 

 

 

Slika 7 Steamboat Willie (izvor: https://filmschoolrejects.com/mickey-mouse-steamboat-willie/) 

 

Disney je kasnije dodao sinkroniziranu glazbu na film "The Skeleton Dance" iz 1929. godine. 

Također, 1932. je animiranom filmu "Flowers and Trees" dodao boju koristeći Technicolor, a 

1937. je stvorio iluziju dubine korištenjem multiplan kamere ili kamere s više razina u filmu "The 

Old Mill". 

Uz pomoć svojeg prijatelja iz djetinjstva, Ub Iwerksa, Disney se stalno približavao sve 

savršenijoj i prirodnijoj animaciji. Ub Iwerks bio je ključan u stvaranju kamere s više razina i 

tehnika sinkronizacije koje su činile crtiće višedimenzionalnim. [8] 

 

Prvi dugometražni animirani Disneyev film bio je "Snjeguljica i sedam patuljaka" iz 1937. 

godine (Slika 8). Iako nije bio prvi animirani film, bio je prvi koji je koristio najnovije tehnike i 

postao je izuzetno popularan. Za razliku od drugih animiranih filmova iz toga razdoblja, koji su 

https://filmschoolrejects.com/mickey-mouse-steamboat-willie/
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većinom imali jednostavnu radnju i dijalog, "Snjeguljica i sedam patuljaka" imala je puno 

kompleksniju radnju temeljenu na bogatoj bajci i dublju poruku. [8] 

 

 

Slika 8 Snjeguljica i sedam patuljaka (izvor: https://www.art-kino.org/hr/film/snjeguljica-i-sedam-

patuljaka) 

 

Animirani film "Snjeguljica i sedam patuljaka" koristio je cel animaciju. Cel je prozirna 

plastična folija koja se koristila za ručno crtanje filmova tradicionalnom tehnikom 2D animacije. 

[9] [10] 

 

2.1.1. 12 principa animacije 

Disney je 1930-ih predstavio 12 popularnih principa animacije, kojih se još uvijek, nakon 100 

godina, drže animatori. Ova načela animacije potrebna za oživljavanje likova predstavljena su u 

knjizi “The Illusion of Life: Disney Animation” autora Disneyevih animatora Franka Thomasa i 

Ollieja Johnstona. [11] 

 

1.  Načelo animacije: Squash i Stretch 

 

Sažimanje i istezanje su temeljni i najvažniji principi animacije. Pomoću ovog efekta stvara se 

iluzija težine i volumena kod animiranih objekata, čime se postiže realističnija i uvjerljivija 

animacija. Na ovaj način prenosi se elastičnost i težina lika, a ovisno o tipu animacije, možemo 

pretjerati s ovim efektom. [11] [12] 

 

https://www.art-kino.org/hr/film/snjeguljica-i-sedam-patuljaka
https://www.art-kino.org/hr/film/snjeguljica-i-sedam-patuljaka


14 

 

2.  Načelo animacije: Predviđanje 

 

Načelo predviđanja priprema gledatelja za radnju koja će se dogoditi pomoću kratke stanke 

prije samog čina. Ovo je moćna tehnika kojom se privlači pozornost gledatelja i često se koristi 

prije skoka, udarca, zamaha ili bacanja. [11] [12] 

 

3.  Načelo animacije: Inscenacija 

 

Ovaj princip objašnjava kako bi likovi i objekti trebali biti postavljeni unutar kadra kako bi 

gledateljima bilo jasno što se događa na sceni. To se postiže kompozicijom, osvjetljenjem i 

položajem kamere. [11] [12] 

 

4.  Načelo animacije: Izravna akcija i poza do poze 

 

„Straight-ahead“ i „pose-to-pose“ su zapravo dvije tehnike crtanja neke radnje u animaciji. 

Pravo naprijed je uzastopno crtanje kadrova od početka do kraja radnje, dok poza do poze 

podrazumijeva crtanje ključnih kadrova (eng. Keyframe) prvo, a zatim popunjavanje ostalim 

kadrovima. Obje tehnike imaju prednosti i mane, te ih je bitno znati primijeniti u pravoj 

situaciji. [11] [12] 

 

5.  Načelo animacije: Kontinuirano i preklapajuće djelovanje 

 

„Follow-through“ i „overlapping actions“ su principi koji stvaraju prirodniju, realističniju i 

fluidniju radnju. To se postiže pomicanjem dijelova objekta neovisno jednih o drugima. Na 

primjer, ako razmotrimo radnju trčanja, primijetit ćemo da se sam lik kreće prema naprijed, 

njegova kosa leti prema natrag, a ruke mu se ljuljaju lijevo - desno. [11] [12] 

 

6.  Načelo animacije: Spori ulazi i spori izlazi 

 

U stvarnom životu objekti ne kreću se i ne zaustavljaju se odjednom s konstantnom brzinom. 

Prvo polako kreću dok ne postignu željenu brzinu, a isto tako, ali suprotno, vrijedi za 

zaustavljanje. Kako bi animacija izgledala što uvjerljivije, primjenjujemo ovo i na njezine 

objekte. To postižemo dodavanjem više kadrova na početak ili kraj radnje kako bismo usporili 

ili ubrzali radnju. [11] [12] 
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7.  Načelo animacije: Arcos 

 

Prema ovom načelu animacije, pokret likova koji se kreću prati krivulju, a ne ravnu liniju. Kada 

zamislimo osobu kako hoda, njezine ruke i noge slijede krivulju. Također, ako zamislimo kako 

netko baca loptu, putanja lopte bit će zakrivljena. Ovo je ključno za stvaranje prirodnog i 

organskog pokreta jer se pridržava zakona fizike. [11] [12] 

 

8.  Načelo animacije: Sekundarna radnja 

 

Sekundarna radnja prati glavnu radnju s ciljem da glavna radnja izgleda realističnije ili da joj 

da neki poseban efekt. Ako je primarna radnja, na primjer, hodanje, tada je sekundarna radnja 

ljuljanje ruku lijevo - desno. Ona nastaje kao posljedica primarne radnje i naglašava je, čineći 

primarnu radnju realističnijom. [11] [12] 

 

9.  Načelo animacije: Termin 

 

Jedan od glavnih elemenata animacije definitivno je "timing" jer definira tempo scene i brzinu 

kojom će se likovi kretati. Za ovo načelo trebali bismo također uzeti u obzir zakone fizike. [11] 

[12] 

 

10.  Načelo animacije: Pretjerivanje 

 

Pretjerivanje je tehnika prenaglašavanja karakterovog pokreta kako bi ga gledatelj jasno 

primijetio. On doprinosi dramatičnijem dojmu i čini animaciju upečatljivijom. [11] [12] 

 

11.  Načelo animacije: Čvrstoća 

 

Ovo načelo doprinosi trodimenzionalnom izgledu 2D animacije. Svaki animator trebao bi 

savladati anatomiju, oblik i težinu lika kako bi ga što realističnije prikazao. [11] [12] 

 

12.  Načelo animacije: Osobnost i privlačnost 

 

Ključ uspjeha animacije su zanimljivi, jedinstveni i karizmatični likovi. Korištenjem različitih 

oblika, boja, preuveličavanjem, naglašavanjem i pokretima, animirani lik postaje mnogo 

upečatljiviji i privlači pažnju gledatelja. [11] [12]  
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2.2. Računalna animacija 

Od trenutka nastanka prvog dugometražnog animiranog filma, "Snjeguljica i sedam patuljaka" 

sve do danas, mnogo se toga promijenilo u svijetu animacije. Većinu tih promjena izazvao je jedan 

uređaj - računalo. 

 

Nakon Disneyja, koji se smatra prvom prekretnicom ili revolucijom u animaciji, dolazimo do 

druge najveće prekretnice. 1995. godine izašao je Pixarov prvi potpuno računalno animirani 

dugometražni film "Priča o igračkama" (glavni likovi Tim Allen i Tom Hanks u ulozi Buzza 

Lightyeara i šerifa Woodyja prikazani na slici 9). [7] 

 

 

Slika 9 Toy Story (1995) (izvor: https://www.imdb.com/title/tt0114709/) 

 

Animirani film "Priča o igračkama" pokazao je potencijal računalne animacije, potaknuo njezin 

napredak i oblikovao način na koji se danas izrađuju animirani filmovi. Za izradu računalne 

animacije koristili su suvremene CGI (Računalno generirane slike, eng. Computer-Generated 

Imagery) tehnike. [7] 

 

2.2.1. CGI (eng. Computer-Generated Imagery) 

Računalno generirane slike, skraćeno CGI, stvaraju nepokretan ili animirani sadržaj pomoću 

računalnog softvera. Koristi se za stvaranje 2D ili 3D sadržaja pogodnog za ekran, film, televiziju, 

računalne igre, virtualnu stvarnost, reklame… 

https://www.imdb.com/title/tt0114709/
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CGI se obično koristi za stvaranje 3D likova, scena i drugih specijalnih efekata u filmovima i 

video igrama. U filmovima se često koristi s stvarnim sadržajem kako bi se postigli različiti efekti 

koji izgledaju toliko realistično da gledatelji povjeruju u njih. Animirani filmovi danas često 

izgledaju kao klasični crtići, a zapravo su napravljeni pomoću CGI-a. [13] [14] 

 

Računalno generirana slika se prvi puta pojavila 1958. godine u 2D animiranom filmu 

"Vertigo" Alfreda Hitchcocka. Slika 10 prikazuje računalno generiranu sliku iz uvodne špice 

filma. [13] 

 

 

Slika 10 Vertigo (1958) (izvor: https://www.youtube.com/watch?v=GQwp6M2q1NE) 

 

2.3. 2D animacija 

2D animacija je proces kreiranja iluzije pokreta u dvodimenzionalnom prostoru. Iluzija pokreta 

postiže se stvaranjem slika ili okvira (eng. Frames) koje se gledaju u nizu. Jedna sekunda u 

animaciji najčešće predstavlja 24 slika, ali obično se animira svaka druga, što znači da ih je ukupno 

12. Disneyovih 12 principa animacije ključni su za stvaranje uvjerljive 2D animacije. 

 

Tradicionalna 2D animacija se crtala ručno, ali sada se može i računalno generirati. Današnja 

tehnologija omogućuje animatorima da stvore „kostur“ lika i kažu računalu koje dijelove treba 

pomaknuti i u kojem smjeru. Računalo samo za nas generira slike između dvije pozicije kako bi 

se dobio postepeni prijelaz. To je velika ušteda vremena za animatore, koji ne moraju ponovno 

crtati lik za svaki kadar. Ovo je glavna razlika između računalne 2D animacije i tradicionalne 2D 

animacije. Računalna animacija nam omogućuje da ručno nacrtamo nekoliko kadrova i pomoću 

računala te kadrove manipuliramo kako bi dobili željeni pokret. [15] [16] [17] 

https://www.youtube.com/watch?v=GQwp6M2q1NE
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2.3.1. Programi za izradu 2D animacije 

Računalna animacija se i dalje pridržava pravila i načela koja se koriste pri izradi tradicionalne 

animacije, ali sada mnogo posla obavlja računalo pomoću raznih alata. Listove papira ili cel folije 

zamijenile su digitalne datoteke. Sada, uz pomoć jednog programa, možemo nacrtati animaciju, 

koristiti različite efekte i alate za manipulaciju, dodati razne datoteke, zvukove i glazbu, te na kraju 

renderirati samu animaciju kako bismo stvorili video. 

Danas postoji mnoštvo programa za izradu 2D animacije, uključujući širok izbor potpuno 

besplatnih i onih koji se naplaćuju. 

 

Neki od najpopularnijih besplatnih programa za izradu 2D animacije su Synfig, OpenToonz, 

Pencil2d, Krita i Blender. Od programa komercijalnih programa, najčešće se spominju Toon Boom 

Harmony, Adobe programi (posebno Adobe Animate) i Moho Pro. 

 

U ovom radu opisan je jedan besplatan program (OpenToonz) i jedan komercijalni program za 

izradu 2D animacije (Adobe Animate). 
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3. OpenToonz 

OpenToonz je besplatan program otvorenog koda (svatko može pristupiti izvornom kodu 

programa i modificirati ga) za izradu 2D animacije. Budući da je besplatan i otvorenog koda, može 

ga koristiti bilo tko za komercijalne ili nekomercijalne projekte, profesionalnu produkciju, 

amatersku produkciju i školsko obrazovanje. [18] 

 

 

Slika 11 Opentoonz logo (izvor: https://freesvg.org/opentoonz-1) 

 

Izvorna verzija OpenToonz-a je program Toonz, koji je razvio Digital Video S.p.A. u Italiji. 

Prvi puta je objavljen 1993. godine i ubrzo je postao moćan alat za 2D animaciju. Prvobitna svrha 

programa bila je pomoći u stvaranju tradicionalne 2D animacije. Njegova sposobnost 

kombiniranja ručno nacrtanih slika s digitalnim crtežima privukla je pažnju japanskog Studia 

Ghibli. OpenToonz je prilagođen od strane Studia Ghibli i koristi se za stvaranje njihovih djela 

već niz godina. Studio Ghibli je koristio ovaj program za izradu mnogih poznatih animiranih 

filmova, uključujući Princess Mononoke, The Tale of Princess Kaguya, The Wind Rises, Ponyo i 

Howl's Moving Castle. [18] [19] 

 

 

Slika 12 Princess Mononoke (1997.) (izvor: https://characterdesignreferences.com/art-of-animation-

4/art-of-princess-mononoke) 

https://freesvg.org/opentoonz-1
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Kasnije je Dwango pokrenuo projekt OpenToonz u suradnji s Digital Video i Studiom Ghibli. 

Digital Video i Dwango sklopili su ugovor pod uvjetom da će Dwango objaviti i razvijati platformu 

otvorenog koda temeljenu na Toonz-u. U ožujku 2016. godine objavljen je OpenToonz i svi ga od 

tada mogu besplatno preuzeti. 

OpenToonz još nosi nadimak „Toonz Ghibli Edition“ jer sadrži mnoge značajke koje su 

tijekom godina posebno razvijene za Studio Ghibli. [18] [19] 

 

3.1. Otvaranje novog projekta 

Kada se po prvi put otvori program nakon instalacije, otvorit će se prozor za novi projekt (Slika 

13). Projekt je, u suštini, mapa u koju će se spremiti sve datoteke vezane za određenu animaciju. 

 

 

Slika 13 OpenToonz - Novi projekt 

 

Novi projekt kreira se odlaskom na File -> Project Menagement -> New project. Pri izradi 

novog projekta (Slika 13) najbitnije je odrediti gdje će projekt biti spremljeni, automatski se 

sprema u C:\OpenToonz stuff\projects, i naziv projekta (eng. Project Name). Moguće je odmah 

dodati u projekt neke dokumente kao što su inputs, drawings, scenes, extras, outputs, palettes i 

scripts. Za stvaranje projekta potrebno je odabrati „OK“. 
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Ove datoteke se mogu dodati i naknadno odlaskom na File -> Project Management -> Project 

Settings (Slika 14). Jednom kada je projekt kreiran više mu nije moguće mijenjati ime ili mjesto 

gdje je on pohranjen.   

 

 

Slika 14 OpenToonz - Postavke projekta 
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3.2. Sučelje 

Nakon kreiranja projekta otvara se prazno sučelje programa (Slika 15).  

 

 

Slika 15 OpenToonz - Sučelje 

 

3.2.1. Sobe 

OpenToonz sučelje je organizirano u sobe (eng. Rooms), poznate kao i radni prostori (eng. 

Workspaces) (Slika 17). Svaka soba ima drugačiji raspored različitih prozora koji su prilagođeni 

određenom procesu animacije. One se mogu preimenovati i može se mijenjati raspored njenih 

prozora. Nove sobe se mogu dodavati, a postojeće brisati. Kada se nova soba kreira ona je u 

potpunosti prazna i mogu se dodavati novi prozori po želji. 

 

Sobu možemo odabrati u desnom djelu menu trake. Ime sobe možemo promijeniti dvostrukim 

klikom na određenu sobu. Možemo promijeniti i redoslijed u kojem su prikazane sobe u manu 

traci tako da kliknemo i povučemo sobu na željenu poziciju. Desnim klikom na bilo koju sobu 

dobivamo opciju za stvaranje nove sobe (New Room), a desnim klikom na bilo koju sobu i opcijom 

Delete Room 'Naziv sobe' moguće ju je obrisati. Ne možemo brisati sobu u kojoj se trenutno 

nalazimo. 

1 

6 
2 

3 

4 

5 
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U svakoj sobi se može mijenjati veličina prozora, prozori se mogu dodavati i brisati. 

Konfiguracija sobe se može zaključati kako bi se izbjegla njezina slučajna promjena (najdesniji 

gumb u menu traci) (Slika 16). Ako želimo vratiti sobe na originalne postavke OpenToonz-a 

odlazimo na Windows -> Workspace - > Reset to Default Rooms. 

 

 

Slika 16 OpenToonz - Zaključavanje konfiguracije sobe 

 

Veličinu okna mijenjamo tako da kliknemo na vertikalni ili horizontalni separator i povučemo 

ga s mišem do mjesta s kojim smo zadovoljni. Klikom na Windows dobivamo izbornik s prozorima 

koje je moguće otvoriti. Njihovu veličinu moguće je promijeniti klikom i povlačenjem ruba 

prozora.  

 

 

Slika 17 OpenToonz - Pregled postojećih soba 

 

Drawing soba 

Drawing soba služi za crtanje i bojanje. Njezin originalni raspored prikazan je na slici 18. 

 

 

Slika 18 OpenToonz - Drawing soba 



24 

 

Cleanup soba 

Cleanup soba služi za uređivanje skeniranih crteža u programu (Slika 19). OpenToonz ima 

mogućnost da skenirane rukom nacrtane crteže na papiru dodamo u program. Proces čišćenja (eng. 

Cleanup) uključuje centriranje svakog crteža te automatsko prepoznavanje linija crteža koje 

postaju rasterske linije u programu. 

 

 

Slika 19 OpenToonz - Cleanup soba 

 

Palette soba 

Drawing soba služi za promjenu i odabir boja tijekom crtanja. Ovdje je moguće vidjeti sve boje 

i palete koje se koriste na trenutnom levelu. Njezin originalni raspored prikazan je na slici 20. 

 

 

Slika 20 OpenToonz - Palette soba 
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InkNPaint soba 

InkNPaint soba omogućuje veliki prostor za crtanje. Njezin originalni raspored prikazan je na 

slici 21. 

 

 

Slika 21 OpenToonz - InkPaint soba 

 

Animation soba 

Animation soba uključuje razne alate za animiranje, prikaz sheme animacije ili upotrebe FX-

a, razine i X-Sheet (omogućuje upravljanje sadržajem scene). Njezin originalni raspored prikazan 

je na slici 22. 

 

 

Slika 22 OpenToonz - Animation soba 
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Schematic soba 

Schematic soba prikazuje sheme animacije ili upotrebe FX-a. Njezin originalni raspored 

prikazan je na slici 23. 

 

 

Slika 23 OpenToonz - Schematic soba 

 

X-Sheet soba 

X-Sheet soba služi za upravljanje sadržajem scene. Njezin originalni raspored prikazan je na 

slici 24. 

 

 

Slika 24 OpenToonz - X-Sheet soba 
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Task soba 

Task soba sadrži stablo zadataka sa svim zadacima. Iz stabla zadataka moguće je pokrenuti ili 

zaustaviti izvršenje zadatka ili ga ukloniti. Njezin originalni raspored prikazan je na slici 25. 

 

 

Slika 25 OpenToonz - Task soba 

 

Browser soba 

U Browser sobi moguće je pregledavati datoteke koje se nalaze u projektu. Njezin originalni 

raspored prikazan je na slici 26. 

 

 

Slika 26 OpenToonz - Browser soba 
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3.2.2. Preglednik (eng. Viewer) 

Viewer je radno područje u kojem je moguće crtati, bojati, uređivati crteže, animirati i vidjeti 

rezultate animacije (Slika 27). Beskonačan je i zato ga je moguće pomicati, skalirati i rotirati. 

 

 

 

Slika 27 OpenToonz – Viewer 

 

1. Informacije 

U gornjoj traci s lijeve strane nalaze se informacije o tome što je trenutno prikazano i odabrano. 

Vidljivo je o kojoj sceni se radi, kadru i koliki je postotak zumiranja preglednika. 

 

2. Način prikaza 

S desne strane nalazi se skup gumba koji omogućuju način prikaza. 

 

3. Gumbi za reprodukciju animacije 

Na dnu se nalazi traka s gumbima za reprodukciju animacije. Osim gumbi za pokretanje i 

zaustavljanje animacije postoji još gumbi za odlazak na prvi i zadnji kadar, odlazak na prijašnji i 

sljedeći kadar, te Loop (beskonačna reprodukcija) gumb. Također, skroz desno se možemo 

mijenjati FPS. 

 

 

1 2 

3 
4 
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4. Traka kadrova (eng. Frame bar) 

Skroz na dnu nalazi se traka kadrova koja omogućuje postavljenje trenutnog kadra i kretanje 

kroz kadrove animacije. Kada je reprodukcija aktivirana, na lijevoj strani se prikazuje broj kadrova 

u sekundi. 

3.2.3. Xsheet/Timeline 

Xsheet je digitalna verzija tradicionalnog liste ekspozicije koji omogućuje kontrolu svih 

elemenata scene. Svaki stupac Xsheet-a sadrži jedan sloj animacije (Level), a svaki redak 

predstavlja kadar sloja (Slika 28). 

 

 

Slika 28 OpenToonz – Xsheet 
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Timeline je vodoravni ekvivalent Xsheet-a, ima istu svrhu i funkcionalnost. Jedina razlika je u 

tome da su slojevi ili postavljeni u retke, a stupci prikazuju kadrove. U gornjem dijelu Timeline-a 

nalazi se ravnalo koje prikazuje broj kadrovi, s kursorom postavljenim na trenutni kadar (Slika 

29). 

 

 

Slika 29 OpenToonz – Timeline 

 

Iznad Timeline-a nalaze se gumbi za stvaranje novih slojeva (Slika 30 - 1) i gumbi za 

upravljanje kadrovima (Slika 30 - 2). Pomoću njih moguće je produljiti ili skratiti vrijeme trajanja 

kadra, može ih duplicirati, preokrenut itd.  

 

 

Slika 30 OpenToonz - Timeline alati 

 

Slojevi 

U slojeve možemo učitati razine animacije, video isječke, slike, zvuk ili druge vremenske trake. 

Svaki kadar čita sve slojeve od dolje prema gore, što znači da će prvi sloj biti prikazan kao 

pozadina.  

 

Slojeva mogu imati različite boje ovisno o vrsti levela koju sadrže. Toonz Vector level je tamno 

žuti, Toonz Raster level je zeleni, Raster level je svijetlo plavi, Sub-Xsheet je ljubičasti, Effect 

level je smeđi i Audio level je svjetlo zeleni. 

 

Više slojeva moguće je označiti držanjem tipke Shift i klikom na slojeve koje želimo označiti. 

Klikom na sloj i povlačenjem moguće je mijenjati redoslijed slojeva. Desnim klikom na sloj 

moguće ga je kopirati, izrezati, zalijepiti obrisati… 

Svakom sloju moguće je promijeniti ime dvostrukim klikom na naziv (Slika 31 - 1), moguće 

je mijenjati vidljivost u finalnom videu (Slika 31 - 2) i na kameri u pregledniku (Slika 31 - 3), 

1 2 
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moguće je zaključati sloj što onemogućuje bilo kakvo uređivanje (Slika 31 - 4), moguće je 

promijeniti transparentnost sloja i dodati filter u boji klikom na strelicu (Slika 31 - 5). 

 

 

 

Slika 31 OpenToonz - Slojevi 

 

3.2.4. Palette i Style Editor 

U OpenToonz-u, Toonz Vector i Toonz Raster slojevi dolaze s vlastitom paletom koja sadrži 

stilove koji se mogu koristiti za crtanje linija i bojanje. Stilovi su interaktivno povezani s crtežom, 

to jest kada promijenite stil u paleti automatski se mijenja i dio crteža koji koristi taj stil. To 

omogućuje promjenu boje nakon završetka procesa crtanja bez potrebe za ispravljanjem svakog 

kadra. 

 

Palette Editor 

U paleti se nalaze stilovi koji se koriste za crtanje i bojanje na označenom sloju. Paleta svakog 

novog Vector sloja sadrži samo običnu crnu boju, a paleta novog Raster sloja sadrži običnu crnu 

boju, ili boje prepoznate tijekom procesa čišćenja (skeniranja). Svaka paleta uvijek sadrži stavku 

Color_0 koja omogućuje uklanjanje bilo kojeg stila iz crteža. Također, svaka paleta može imati 

najviše 4096 stilova. 

 

 

Slika 32 OpenToonz - Palette Editor 

 

1 2 3 4 5 
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Paletu je moguće aktivirati ili deaktivirati i pohraniti. Za kreiranje novog stila potrebno je 

kliknuti gumb + (Slika 32). Desnim klikom svaki stil je moguće kopirati i izrezati, te zalijepiti 

naziv i boju, zalijepiti samo boju ili samo naziv i možemo obrisati sloj. 

 

Style Editor 

Stilovi se mogu mijenjati pomoću Style Editora. Boja, tekstura, vektor i raster su 4 vrste stila 

koje se mogu odabrati. Samo prvi stil u paleti, označen Color_0, se ne može uređivati. 

Gumb Auto omogućuje da se izmjene automatski dodjeljuju stilu, gumb Primijeni dodjeljuje 

stil nakon što se on odabere. 

 

 

Slika 33 OpenToonz - Auto/Apply gumb 

 

Boja 

Boja stila se može definirati pomoću nijanse i zasićenosti (Slika 34 - 1). Klizač Alpha određuje 

prozirnost boje, što je vrijednost niža, to je boja prozirnija (Slika 34 - 2). 

Odabir boje može se izvršiti preko klizača ili koluta boja (Slika 34 - 3). Boje se također mogu 

odabrati iz Preglednika pomoću alata RGB Picker. 

 

 

Slika 34 OpenToonz - Boja 

1 

2 

3 
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Teksture 

Teksture se također mogu koristiti za crtanje i bojanje. Stilovi teksture mogu se koristiti i na 

Toonz Vector i Toonz Raster slojevima. Uz program dolazi nekoliko tekstura, ali se mogu dodati 

vlastite teksture. 

 

Niz slika se također može učitati kao tekstura i kao takva ona će se mijenjati sa svakim novim 

okvirom na vremenskoj traci. 

 

 

Slika 35 OpenToonz - Tekstura 

 

„Texture mapping“ je način na koji se tekstura primjenjuje na linije i obojana područja. 

Drugačije se primjenjuje na rasterski i vektorski sloj. 

Vektor mapiranje teksture izvodi pomoću parametarskih koordinata poteza vektora. Za linije 

tekstura automatski "prate" oblik i debljinu poteza, za područja slika teksture je popločana da 

pokrije područje obojeno stilom. Raster mapiranje teksture izvodi se pomoću standardnih 

koordinata mapiranja. To znači da je slika teksture popločana kako bi pokrila linije ili područja 

obojena stilom. 

 

Teksture primijenjene na stilove koji se koriste u Raster slojevima omogućuju postavljanje 

različitih parametara kao što su pozicija, skala, rotacija, X-os, Y-os i kontrast. 
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Generirani stilovi 

Generirani stilovi koriste niz matematičkih funkcija za stvaranje efekata koji se mogu koristiti 

za vektorske poteze ili bojanje područja definiranih vektorima. Mogu simulirati potez kistom, 

točkice, crtice, valove, gradijent itd. 

 

Boje koje koriste generirani stilovi mogu se mijenjati pomoću kartice Color . Prva stavka na 

popisu generiranih stilova omogućuje uklanjanje generiranog stila i vraća običnu boju. 

 

 

Slika 36 OpenToonz - Generirani stilovi 

 

Tragovi 

Stil tragova može se samo primijeniti na vektore. Stil traga ponavlja sliku ili sloj animacije, 

stvorenu pomoću OpenToonz-a ili nekog drugog programa. 

Slike koje se ponavljaju mijenjajući svoj položaj i veličinu prema obliku i debljini vektora. 

Parametri tragova se mogu definirati u Postavkama. 

 

 

Slika 37 OpenToonz - Tragovi 
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Vektorski kistovi 

Na vektorskim slojevima za crtanje koriste se vektorski kistovi. Oni primjenjuju vektorsku 

sliku na kreiranu liniju vektora kako bi se stvorila iluzija kista. Slika vektorskog kista primjenjuje 

se na svaki potez crteža koji koristi ovaj stil prema obliku i debljini poteza. 

Prvi kist na popisu zapravo omogućuje uklanjanje vektorskog kista i ostavlja samo boju. 

 

 

Slika 38 OpenToonz - Vektorski kistovi 

 

Rasterski kistovi 

Rasterski kistovi se naravno koriste na rasterskim razinama i koriste boju iz trenutnog stila kao 

osnovu. Kistovi su kompatibilni sa softverom za slikanje otvorenog koda MyPaint. 

 

 

Slika 39 OpenToonz - Rasterski kistovi 
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3.2.5. Level Strip  

Level Strip prikazuje sve crteže koji se nalaze na označenom sloju, bez obzira jesu li u 

Timeline-u ili ne, poredani po numeraciji (Slika 40). 

 

 

Slika 40 OpenToonz - Level Strip 

 

Kada odaberemo crtež s trake, prikazuje se sam, bez drugog sadržaja, kako bi se olakšalo 

upravljanje njime (Slika 41). 

 

 

Slika 41 OpenToonz - Level Strip (Prikaz u pregledniku) 



37 

 

Crteže u Level Strip-u možemo kopirati, rezati, zalijepiti, dodavati nove crteže i mijenjati 

njihov redoslijed. 

 

3.2.6. Alati 

Alatna traka sadrži alate za crtanje, odabir i uređivanje crteža, te za animiranje objekata. 

 

Animate  

Alat Animate omogućuje promjenu položaja, rotacije i veličine trenutnih objekata. 

 

 

 

Slika 42 OpenToonz - Opcije alata Animate 

 

1. Objekt 

U prvom padajućem izborniku moguće je odabrati koji objekt iz naše scene će biti podložan 

utjecaju ovog alata. 

 

2. Način transformacije 

Mogućnost odabira načina transformacije objekta. Opcije transformacije uključuju položaj, 

rotaciju, skaliranje, pomak, centar i sve. 

 

3. Opcije transformacije 

Kada je način transformacije odabran, sa desne strane dobivamo dodatne opcije za tu 

transformaciju. 

 

Position 

Položaj omogućuje promjenu X i Y koordinata objekta. Također može mijenjati Z koordinatu 

kako bi se definirala dubina objekta u 3D prostoru. 

 

Rotation 

Rotacija okreće odabrani objekt oko Z osi. 

 

1 2 3 
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Scale 

Ova opcija omogućuje promjenu veličine objekta. Moguće je skalirati samo po visini (V), samo 

po dužini (H) ili istovremeno po visini i dužini (Global). 

 

Shear 

Ova opcija omogućuje vodoravno i okomito smicanje odabranog objekta. 

 

Centar 

Ova opcija omogućuje postavljanje vodoravnog i okomitog položaja središta odabranog 

objekta (ne može se animirati). 

 

All 

Ova opcija prikazuje sve vrste transformacija istovremeno i koristi se uz pomoć ručice koja 

omogućuje bilo koju vrstu transformacije u pregledniku. 

 

 

Korištenje Animate alata u animaciji 

Za postizanje efekta pomicanja šešira kad zapuše vjetar, koristi se alat Shear za smicanje.. 

 

 

Slika 43 OpenToonz – Shear alat 
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Alat je moguće koristiti na dva načina: ručnim unosom vrijednosti u traci s opcijama alata ili 

povlačenjem mišem u pregledniku dok se ne postignu željeni rezultati. 

 

 

Slika 44 OpenToonz - Rezultat Shear alata 

 

Da bismo stvarno stvorili animaciju pomoću ovog alata, moramo koristiti Timeline. Tamo 

trebamo odabrati kadar s kojeg želimo započeti radnju. Taj kadar postaje ključni kadar (eng. 

Keyframe). 

Keyframe 

Ključni kadar ili Keyframe definira početak i/ili završetak glatkog prijelaza. U animaciji, to je 

crtež; u filmu, kadar videa. Ključni kadrovi postavljaju parametre za ostale kadrove i ukazuju na 

promjene koje će se dogoditi. [20] 

 

Nakon što je kadar koji će postati ključan odabrani, u OpenToonz-u potrebno je pritisnuti tipku 

Z ili desni klik na kadar -> Set Key. Na kadru će se prikazati bijela točkica koja indicira da se radi 

o Keyframe-u (Slika 45). 

 

 

Slika 45 OpenToonz - Keyframe 
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Nakon što je stvoren ključni kadar s kojeg počinje promjena ili animacija, odlazimo na kadar 

u kojem definiramo promjenu. Razmak između ključnog kadra i promjene određuje koliko će 

trajati transformacija. U tom okviru koristi se alat Shear. Taj kadar automatski postaje ključni 

kadar i označen je bijelom točkicom. 

 

U Timeline-u, svi ključni kadrovi bit će "povezani" bijelom crtom (Slika 46). To znači da je 

program automatski generirao međukadrove kako bi se postigao glatki prijelaz. 

 

 

Slika 46 OpenToonz - Prikaz pokreta u Timeline-u 

 

Na slici 47, pod brojem 1 je početni ključni kadar. Pod brojem 3 je zadnji ključni kadar radnje 

(na njemu je korišten alat Shear), a pod brojem 2 je jedan od međukadrova kojeg je računalo 

generiralo kako bi prijelaz između 1 i 2 bio glatki i postepen. 

 

 

 

Slika 47 OpenToonz - Keyframe-ovi i međukadar 

 

 

 

 

 

 

 

 

 

 

1 2 3 
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Selection  

Alat za odabir (eng. Selection) omogućuje uređivanje, pomicanje, rotiranje, skaliranje i 

iskrivljenje dijela ili cijelog crteža. 

 

 

 

Slika 48 OpenToonz - Opcije alata Selection 

 

1. Vrsta odabira 

Možemo odabrati način odabira. Opcije odabira su pravokutni, slobodni i poligoni. 

 

2. Skaliranje 

Vodoravno i okomito skaliranje trenutnog odabira. 

 

3. Link 

Ako je Link uključen, zadržava proporciju odabira. 

 

4. Rotacija 

Rotacija trenutnog odabira. 

 

5. Pomak 

Okomiti i vodoravni pomak za odabir. 

 

Rectangular 

Odabir područja u obliku pravokutnika koji se definira klikom i povlačenjem u pregledniku. 

 

Freehand 

Odabir područja slobodnim, rukom nacrtanim oblikom koji se definira klikom i povlačenjem 

u pregledniku. 

 

Polyline 

Odabir područja definira niz linija u pregledniku. 

 

 

1 2 3 4 5 
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Slika 49 OpenToonz – Selection alat 

 

Brush  

Kist (eng. Brush) omogućuje crtanje slobodnih linija s odabranim stilom. 

Ako se koristi grafički tablet za crtanje, aktivira se opcija Pritisak. Ona prilagođava debljinu 

kista ovisno o pritisku olovke na tablet. 

 

Vektorski kist 

Kod vektorskih kistova, moguće je odabrati minimalnu i maksimalnu veličinu kista (ove 

postavke su važne kada se koristi opcija Pritisak). Preciznost (eng. Accuracy) određuje koliko će 

linije u pregledniku biti zaglađene. Smooth omogućuje stabilizaciju poteza tijekom crtanja. Ako 

je Snap omogućen, povezivat će pokazivač s drugim već nacrtanim potezima na istom sloju dok 

crtate novi potez. 

 

 

Slika 50 OpenToonz - Vektorski kist 
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Rasterski kist 

Rasterski kist omogućuje samo podešavanje veličine kista. 

 

 

Slika 51 OpenToonz - Rasterski kist 

 

 

Crtanje animaciji 

Prilikom crtanja animacije u OpenToonz-u možemo koristiti opciju Onion skin za lakše crtanje 

neke radnje. 

Onion skin  

Onion skin je opcija koja se koristi za gledanje nekoliko okvira animacije istovremeno. Ova 

opcija je korisna za crtanje koherentnog niza kadrova, što je bitno za glatku animaciju. 

 

 

Slika 52 OpenToonz - Onion skin 

1 

2 
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U OpenToonz-u je moguće vidjeti i prijašnje i buduće kadrove (korisno za kreiranje 

međukadrova). Prijašnji kadrovi su u pregledniku prikazani crvenom bojom, a budući zelenom 

(Slika 52 - 1). Ova opcija se nalazi u traci iznad Timeline-a (Slika 52 - 2), a kadrove je moguće 

uključiti i isključiti klikom na Onion skin traku. Istovremeno je moguće vidjeti više prijašnjih i 

budućih kadrova. 

 

Geometric  

S Geometric alatom možemo crtati pravokutnike, krugove, elipse, poligone i lukove. 

 

 

 

Slika 53 OpenToonz - Opcije alata Geometric 

 

1. Debljina 

Veličina kista koji se koristi za crtanje geometrijskih oblika. 

 

2. Tvrdoća 

Mekoća kista koji se koristi za crtanje geometrijskih oblika. Na slici 54, pod brojem 1 prikazana 

je tvrdoća 100, a pod brojem 2 tvrdoća 0. 

 

3. Oblik 

Određuje vrstu oblika. Dostupni oblici su pravokutnik, krug, elipsa, poligon i luk. 

 

4. Broj strana poligona 

Određuje broj strana poligona. 

 

 

Slika 54 OpenToonz - Geometric alat 

1 2 3 4 

1 2 
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Type  

Type alat dodaje tekst animaciji. U traci s opcijama alata moguće je odabrati font, stil i veličinu 

fonta. 

 

Fill  

Fill ispunjava područja čiji su obrisi definirani bez praznina s trenutno odabranim stilom (Slika 

55). Osim područja, ovim alatom moguće je bojati i linije ili rubove (Slika 55 - 1). 

 

 

Slika 55 OpenToonz - Fill alat 

 

Paint Brush  

Paint Brush alat boja linije i područja na rukom nacrtanim, rasterskim crtežima. 

 

Eraser  

Gumica za brisanje (eng. Eraser) briše vektore na vektorskim slojevima, kao i linije i područja 

na rasterskim slojevima. Pod opcijama alata moguće je odabrati veličinu gumice, njezinu jačinu, 

oblik brisanja (normalno, pravokutno, slobodni oblik i poligoni) i opciju brisanja samo linija, samo 

područja ili oboje. 

 

Tape  

Tape je alat koji spaja dva otvorena kraja jednog ili dva vektora. U rasterskim crtežima može 

spojiti praznine. 

 

 

 

1 2 
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Style Picker  

Stil na koji se klikne u pregledniku kapaljkom za stilove (eng. Style Picker) postaje trenutni 

stil.. 

 

RGB Picker  

RGB kapaljka odabire crvene, zelene i plave vrijednosti iz preglednika i primjenjuje ih na 

trenutni stil. 

 

Control Point Editor  

Control Point Editor modificira vektorski oblik pomoću njegovih točaka. 

 

Pinch  

Pinch mijenja vektorski oblik klikom i povlačenjem bilo gdje na vektoru. 

 

Pump  

Pump mijenja debljinu vektora klikom na dio vektora i zatim povlačenjem gore ili dolje. 

 

Magnet  

Magnet deformira nekoliko vektora odjednom klikom na područje na koje želite utjecati i 

povlačenjem. 

 

Bender  

Bender savija vektore. 

 

Iron  

Iron uklanja nabore s vektora. 

 

Cutter  

Cutter dijeli vektor na dva dijela kada se klikne na njega. 
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Skeleton  

Alat Skeleton omogućuje postavljanje hijerarhijskih veza između dijelova lika i njegovo 

animiranje (izrada kostrura). 

 

Hook  

Hooks su referentne točke koje se mogu definirati za bilo koji sloj animacije u pregledniku, 

pomoću alata Hook. One se koriste za pomicanje objekta ili povezivanje jednog objekta s drugim. 

 

Tracker  

Tracker prati određene dijelove u nizu crteža. 

 

Plastic  

Alat Plastic gradi mrežu koja omogućuje deformiranje i animiranje. 

 

Za korištenje ovog alata potreban je barem jedan sloj koji sadrži crtež i na koji se želi 

primijeniti alat. Koristeći obrise crteža, alat Plastic generira trokutastu mrežu koja se nalazi u 

novom sloju Mesh. Svaki novostvoreni Mesh sloj automatski se povezuje s odgovarajućim 

crtežom. 

 

Kada je sloj na kojem se koristiti alat označen, u traci s opcijama alata potrebno je odabrati 

Create Mesh (Slika 56 - 1). 

 

 

 

Slika 56 OpenToonz - Opcije alata Plastic 

 

Mreža je stvarni objekt koji Plastic modificira kada je kostur animiran. Iz tog razloga svi 

elementi koji će biti animirani alatom Plastic trebaju mrežu. 

 

Nakon odabira opcije Create Mesh, otvara se prozor s dodatnim postavkama mreže i njezinim 

pregledom (Slika 57). U prozoru potrebno je izabrati Apply. 

 

1 2 3 
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Slika 57 OpenToonz - Create Mesh 

 

Nakon kreiranja mreže, stvara se novi sloj na kojem se ona nalazi (Slika 58) i postaje vidljiva 

u pregledniku (Slika 59). 

 

 

Slika 58 OpenToonz - Mesh sloj 

 

 

Slika 59 OpenToonz - Mesh u pregledniku 
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U traci s opcijama alata Plastic, moguće je birati između nekoliko načina rada, a to su 

Uređivanje mreže, Definiranje krutosti mreže, Izrada kostura i Animacija. 

 

Uređivanje mreže (eng. Edit Mesh) 

Kreiranoj mreži moguće je pomicati točke, promijeniti smjer ruba kako biste dobili drugačiji 

oblik (Swap), izbrisati rub (Collapse), podijeliti rub kako biste povećali gustoću mreže u određenoj 

točki (Split) i izrezati mrežu (Cut). 

Desni klik na određeni rub koji želimo urediti otvara izbornik s ovim opcijama (Slika 60). 

 

 

Slika 60 OpenToonz - Edit Mesh 

 

Izrada kostura (eng. Build Skeleton) 

Plastic alat ima mogućnost izgradnje specifične strukture kostura koja može kontrolirati mrežu. 

Na taj način moguće je deformirati ili animirati određeni element. Kostur je skup povezanih 

vertexa, a svakom vertexu mogu se odrediti različiti parametri. 

 

 

Slika 61 OpenToonz - Build Skeleton 
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Vertex se kreira klikom miša i veže na prethodno izrađeni vertex ili na vertex koji je bio 

prethodno selektirani klikom miša.  

Jedna mreža može imati više kostura. Broj kostura može se promijeniti u traci s opcijama 

Plastic alata (Slika 56 - 3). 

 

Paint Rigid 

U slučaju kada neki dio mreže mora zadržati svoj oblik iako slijedi transformaciju cijelog 

elementa koristi se ova opciju. 

 

 

Slika 62 OpenToonz - Paint Rigid 

 

Kada je aktivan Paint Rigid selektor u pregledniku postaje alat za crtanje i moguće mu je 

odrediti širinu (Slika 62 - 1). Pomoću njega označuju se dijelovi koji će zadržati svoj oblik. Dio 

mreže obuhvaćen ovim alatom postaje crven (Slika 62).  

 

Animiranje (eng. Animate) 

Za kreiranje animacije potrebno je odabrati vertex-e i pomaknuti ih na željene položaje, 

automatski će se stvoriti ključni okviri animacije. 

 

Efekt da se bršljan pomakne kada puše vjetar postignut je laganim rotiranjem svog lišća 

pomoću vertex-a prema jednoj strani (Slika 63). Ali prvo je bitno postaviti Keyframe na željeni 

početak animacije. 

 

 

1 
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Slika 63 OpenToonz - Animate 

 

Između ključnog okvira i animirane mreže, program sam popunjava međukadrovske sličice 

(Slika 64). 

 

 

Slika 64 OpenToonz - Prikaz animacije na Mesh sloju 

 

Zoom  

Zoom povećava i smanjuje sadržaj preglednika. Povlačenjem prema gore povećavamo radno 

područje i obrnuto. 

 

Hand  

Rukom (eng. Heand) je moguće pomicati radno područje. 

 

Rotate  

Rotacijskim alatom moguće je rotirati radno područje. 
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3.3. Otvaranje nove i spremanje postojeće scene 

Za otvaranje nove scene potrebno je odabrati File -> New Scene ili tipku Ctrl i N. Nakon toga 

se otvara nova, prazna scena prema zadanim postavkama. 

 

Postavke scene i kamere 

Postavke scene otvaraju se tako da se odabere Xsheet -> Scene Settings (Slika 65). 

 

 

Slika 65 OpenToonz - Scene Settings 

 

Postavke kamere otvaraju se tako da se odabere Xsheet -> Camera Settings (Slika 66). 

 

 

Slika 66 OpenToonz - Camera Settings 

 

Za svaku scenu može se definirati više od jedne kamere za dobivanje različite izlazne 

rezolucije. U postavkama kamere moguće je odabrati visinu i širinu kamere, ujedno i radnog 



53 

 

prostora, te DPI. Gumb "Use Current Level Settings" omogućuje da se kamera prilagodi sadržaju 

odabranog sloja. 

 

Ako scena još nije bila spremljena, potrebno je odabrati File -> Save Scene As… U prozoru 

koji se nakon toga otvori, potrebno je odrediti gdje će se scena pohraniti. Inače, scenu se spremaju 

s File -> Save Scene ili pritiskom na Ctrl i S. 

 

3.4. Shema (Stage Schematic) 

Shema sadrži čvorove za sve elemente koji se nalaze na sceni i omogućuje uređivanje njihovih 

međusobnih veza. Organizirana je hijerarhijski počevši od tablice animacije, gdje su smješteni svi 

slojevi. Postoji i čvor kamere. 

Čvorovi se mogu jednostavno dodati, organizirati i odabrati kako bi se izrezali, kopirali, 

zalijepili ili izbrisali. 

 

 

Slika 67 OpenToonz - Stage Schematic 
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3.4.1. Animaciju objekta po zadanoj putanji 

Objekti se mogu kretati po zadanoj putanji. Mogu se animirati bez promjene orijentacije ili s 

automatskom orijentacijom, postavljenom prema smjeru zadane putanje. 

 

Odabranom sloju ili objektu moguće je kreirati putanju desnim klikom u prazno područje 

sheme i odabirom opcije New Motion Path. Objekt i putanja će se automatski spojiti. 

 

 

Slika 68 OpenToonz - Kreiranje putanje 

 

Kada je u shemi odabrana putanja, moguće ju je definirati koristeći Brush alat u pregledniku 

(Slika 69). 

 

 

Slika 69 OpenToonz - Crtanje putanje 
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Jednom kada je objektu dodijeljena putanja, može se kretati po njoj. Objekt je moguće pomicati 

po putanji koristeći alat Animate.  

 

Svaka promjena objekta korištenjem alata Animate stvara Keyframe na označenom kadru. 

Između kadrova na kojima je napravljena promjena objekta stvaraju se međukadrovi, i na taj način 

moguće je animirati objekt (Slika 70). 

 

 

Slika 70 OpenToonz - Animiranje objekta po zadanoj putanji 
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3.5. Primjena efekata 

OpenToonz ima preko 100 efekata koji se mogu primijeniti na razine animacije, slike i isječke 

koji se nalaze na sceni.  

 

Efekte je moguće dodjeliti odabranom objektu u FX shemi desnim klikom na čvor objekta i 

odabirom opcije "Insert FX". Nakon toga će se pojaviti lista iz koje se može odabrati željeni efekt. 

Na prethodno animirani list kojeg „nosi vjetar“ dodaje se efekt Blur -> Motion Blur (Slika 71). 

 

 

Slika 71 OpenToonz - Dodavanje efekta u FX shemi 

 

Dvostruki klik na čvor efekta otvara postavke efekta (Slika 73). 

 

 

Slika 72 OpenToonz - Rad s efektima 
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Slika 73 OpenToonz - Postavke efekta 

 

Efekte i njihove postavke također je moguće animirati. Pritiskom na sivi gumb pored postavke 

(Slika 73) ona će postati Keyframe. 

 

 

Slika 74 OpenToonz - Rezultat efekta 
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3.6. Rendering 

Kako bi se generirala konačna animacija, uključujući sve transformacije i efekte primijenjene 

na objekte scene, scena se mora renderirati. 

 

Postavke renderiranja (Slika 75) otvaraju se putem opcije Render -> Output Settings. 

 

U postavkama je moguće mijenjati postavke kamere, postavke scene i datoteke koje će se 

stvoriti. Odabire se gdje će se datoteka spremiti i u kojem formatu. Animaciju je moguće spremiti 

kao niz slika ili video. 

 

 

Slika 75 OpenToonz - Postavke rendera 
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4. Adobe Animate 

Adobe Animate je aplikacija koja se koristi za stvaranje 2D animacije i interaktivne vektorske 

grafike. Animate je dio Adobe Creative Suite-a (kao Photoshop, Illustrator, InDesign, Premiere 

itd.). Prije nego što je postao Animate, bio je poznat kao Adobe Flash Professional, popularan 

program kasnih 1990-ih i 2000-ih. [21] 

 

 

Slika 76 Adobe Animate logo (izvor: https://en.wikipedia.org/wiki/Adobe_Animate) 

 

Adobe Animate seže u 1993. godinu kada su Jonathan Gay i Charlie Jackson osnovali tvrtku 

pod FutureWave Software i izdali SmartSketch, program za animaciju koji je korisnicima 

omogućavao crtanje na zaslonu računala elektroničkom olovkom. 1995. godine su ga preimenovali 

u FutureSplash Animator i objavili. [21] 

 

Kroz godine programu je nekoliko puta promijenjeno ime i njegove značajke su napredovale s 

razvojem računala i interneta. Prava na program je kupila Macromedia 1996. i u imenu spojila 

„future” i „splash” u „flash“. 2005. godine Adobe je preuzeo Macromedia, a program je dobio ime 

Adobe Flash. 

Adobe Flash postao je vrlo popularan i koristila ga je većina web stranica. Na primjer, kada je 

YouTube pokrenut, koristio je Flash, kao i mnoge igre i interaktivni web alati. Pala mu je 

popularnost nakon što je HTML5 debitirao. Također, program je imao stalne probleme sa 

sigurnosnim propustima. [21] 

 

Adobe Flash je 2016. godine preimenovan u Adobe Animate jer je Adobe želio maknuti fokus 

s Flasha i umjesto toga predstaviti program kao alat za animaciju. Adobe je ukinuo podršku za 

Flash krajem 2020. godine. [21] 

 

https://en.wikipedia.org/wiki/Adobe_Animate
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4.1. Otvaranje novog dokumenta 

Novi dokumetnt u Adobe Animate-u možemo otvoriti odlaskom na File -> New ili Pritiskom 

tipki Ctrl i N (Slika 77). Ako smo tek otvorili program na početnom prozoru možemo odabrati 

Create new.  

 

 

Slika 77 Adobe Animate - Novi dokument 

 

U postavkama dokumenta moguće je odabrati njegovu veličinu i FPS. Kada smo zadovoljni s 

postavkama projekta biramo „OK“. 
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4.2. Sučelje 

Nakon kreiranja novog dokumenta otvara se prazno sučelje programa (Slika 78). 

 

 

Slika 78 Adobe Animate - Sučelje 

 

U sučelju se može mijenjati veličina svih prozora, a prozori se mogu dodavati i brisati. Klikom na 

Window moguće je iz izbornika odabrati novi prozor koji je potreban u sučelju.  

4.2.1. Scena (eng. Scene) 

Scena je radni prostor u kojem se izrađuju i uređuju elementi animacije (Slika 79). Također, 

ovdje se može pregledati rezultat animaciju. 

 

Ako u dokumentu postoji više scena, one se mogu mijenjati u gorenjem lijevom kutu (Slika 77 

- 1). Za izradu ove scene potrebno je odabrati Insert -> Scene. 

U gornjem desnom kutu nalaze se kontrole scene kao što su zoom i rotacija (Slika 79 - 2). 

 

Desni klik na scenu i Document ili Ctrl i J otvaraju postavke scene koje se mogu mijenjati 

(Slika 80). Za spremanje scene potrebno je odabrati File -> Save as ili Save ako je već odabrana 

lokacija dokumenta. 

1 

2 
3 

4 
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Slika 79 Adobe Animate - Scena 

 

 

Slika 80 Adobe Animate - Postavke scene 

  

1 2 
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4.2.2. Timeline 

Svi elementi scene nalaze se u slojevima kojima se može upravljati u Timeline-u (Slika 81). 

Timeline je sastavljen od slojeva koji se sastoje od okvira. Ključni kadrovi označeni su crnom 

točkicom, obični kadrovi su svijetlo sivi, a prazni kadrovi (na njima se ne nalazi objekt) su tamno 

sivi. 

 

 

Slika 81 Adobe Animate - Timeline 

 

Na traci iznad kadrova (Slika 81 - 1) vidljivi je FPS i na kojem je trenutno kadru pokazivač. 

Uz to su i gumbi za manipuliranje kadrovima pomoću kojih je moguće kreirati novi ključni kadar, 

novi prazni kadar i novi obični kadar, te opcija za automatsko dodavanje kadrova i gumb za 

brisanje kadrova. Moguće je uključiti Onion skin i reprodukciju animacije jednom ili beskonačno. 

 

Slojevi 

Svi elementi koji se kreiraju na sceni nalaze se na slojevima, a u njih je moguće i učitati razni 

multimedijski sadržaj kao što su slike, zvuk… (File -> Import) 

Iznad slojeva se nalaze gumbi za njihovu manipulaciju (Slika 81 - 2). Služe za kreiranje novog 

sloja, kreiranje mape i koju možemo staviti slojeve radi bolje preglednosti, brisanje sloja,  skrivanje 

sloja (elementi sloja se ne prikazuju na sceni) i zaključavanje sloja (elementima sloja se ne može 

manipulirati na sceni). Sloj se može preimenovati dvostrukim klikom na njegovo ime. 

4.2.3. Paneli 

Desno od scene nalaze se paneli s raznim stavkama. Paneli se mogu dodavati i uklanjati po 

želji, a zadani paneli od strane programa su Asset panel, koji sadrži simbole koje omogućuje Adobe 

Animate ili koji su kreirani od strane korisnika, Properties panel u kojem su prikazana svojstva, 

Color panel u kojem se može odabrati boja, Align Panel za poravnavanje i Library panel u kojem 

se nalaze resursi animacije. 

1 

2 
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4.2.4. Alati 

 

Slika 82 Adobe Animate - Alatna traka 

 

Selection Tool  

Pomoću alat za odabir (eng. Selection Tool) moguće je odabrati objekt i pomicati ga na sceni. 

 

Free Transform Tool  

Free Transform Tool omogućuje modifikaciju, skaliranje i rotaciju odabranog objekta (Slika 

83). 

 

 

Slika 83 Adobe Animate - Free Transform Tool 

 

Lasso Tool  

Laso alat (eng. Lasso Tool) omogućuje slobodnu selekciju djela objekta, kojeg je onda moguće 

odvojiti (Slika 84).  

Desni klik na Laso alat otvara izbornik s još dva alata za selekciju. To su Polygon, koji koristi 

ravne linije za odabir, i Magic Wand, koji je pametni alat za odabir. 

 

 

Slika 84 Adobe Animate - Lasso Tool 
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Fluid Brush Tool i Classic Brush Tool  

Oba alata služe za crtanje slobodnih linija na sceni (Slika 85). 

 

 

Slika 85 Adobe Animate - Fluid Brush Tool 

 

Razlika je u tome što Classic Brush automatski izglađuje linije crteža, dok Fluid Brush to ne 

radi. Međutim, Fluid Brush omogućuje prilagodbu, dok alat Classic Brush to ne čini. U panelu 

Properties moguće je urediti postavke kista, što znači da ima više mogućnosti i veću kontrolu 

(Slika 86). 

Kod oba kista je moguće odabrati boju, prozirnost i veličinu kista (Slika 86). 

 

 

Slika 86 Adobe Animate - Postavke Fluid Brush Tool-a 
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Eraser Tool  

Eraser Tool je alat za brisanje kreiranih elemenata. U njegovim postavkama možemo mijenjati 

veličinu i oblik. 

 

Rectangle Tool  

Rectangle Tool povlačenjem na sceni stvara pravokutni oblik. Desnim klikom na alat možemo 

doći do Rectangle Primitive Tool-a (pravokutnik kojem možemo zaobliti rubove), Oval Tool-a 

(elipsa), Oval Primitive (elipsa s dodatnim opcijama uređivanja) i PolyStar (heksagon). 

 

 

Slika 87 Adobe Animate - Rectangle Tool 

 

U panelu Properties moguće je promijeniti obliku boju ispune i ruba, odrediti veličinu obruba 

i stil, te način skaliranja (Slika 88). 

 

 

Slika 88 Adobe Animate - Postavke Rectangle Tool-a 
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Line Tool  

Line Tool-om moguće je kreirati linije. U postavkama je moguće odabrati boju, veličinu i stil. 

 

Pen Tool  

Pen Tool klikom stvara točke koje međusobnim povezivanjem stvaraju liniju ili oblik. Desnim 

klikom na alat prikazuje se opcija "Add Anchor Point" za dodavanje točaka i "Delete Anchor" za 

brisanje istih. U postavkama je moguće odabrati boju, veličinu i stil. 

 

Text Tool  

Za dodavanje teksta animaciji potrebno je koristiti Text Tool. U panelu Properties moguće je 

odabrati font, stil, veličinu fonta i boju. 

 

Paint Bucket Tool  

Obojenim područjima moguće je dodati boju Paint Bucket Tool-om, a rubovima s Ink Bottle 

Tool-om. U postavkama je moguće odabrati boju i prozirnost. 

 

Eyedropper Tool  

Kapaljkom (eng. Eyedropper Tool) je moguće s scene klikom odabrati boju. Nakon toga, 

kapaljka se pretvara u Paint Bucket Tool kojim je moguće obojati neko područje. 

 

Asset Warp Tool  

Asset Warp je alat koji stvara mrežu na objektu, a klikom na tu mrežu stvaraju se točke, ili njih 

više, kojima je moguće upravljati mrežom. Deformiranje mreže uzrokuje i deformiranje samog 

objekta. Ovaj alat je koristan za animiranje jer omogućuje jednostavnu i brzu kontrolu kretanja 

objekta. 

 

Slika 89 Adobe Animate - Asset Warp Tool 
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U postavkama nalaze se opcije za modificiranje mreže i kostura (Slika 90). 

 

 

Slika 90 Adobe Animate - Asset Warp Tool postavke 

 

Hand Tool  

Hand Tool služi za pomicanje ili rotiranje scene. 

 

Zoom Tool  

Zoom Tool-om moguće je zumirati scenu. 

 

Bone Tool  

Bone Tool gradi kostur objekta s kojim je moguće pomicati dijelove objekta. 
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4.3. Tweens 

Tweens pojednostavljuje proces animacije tako da funkcionira kao prečac za određene vrste 

uobičajenih animacija. 

 

Tween je skraćenica za "inbetweening", a kada je kreiran na sloju, stvara međukadrovske slike 

(međukadrovi) između Keyframe-ova, što dovodi do glatkog pokreta u animaciji. 

 

Element koji će se animirati s Tween-om prvo mora biti pretvoren u simbol (desnim klikom na 

element na sceni -> Convert to Symbol). Kada je simbol kreiran, dvostruki klik na njega otvara 

novi Timeline koji služi samo za animiranje tog simbola. Ovo je korisno ako element ima više od 

jedne radnje istovremeno. Na primjer, ako se animira lik koji hoda, unutar simbola može se 

animirati pokret nogu, dok se na sceni animira pokret cijelog lika s jednog dijela scene na drugi. 

Simboli omogućuju da glavni Timeline ostane jednostavan i organiziran. 

 

Postoje tri vrste Tween-a: Shape Tween, koji pretvara simbol iz jednog oblika u drugi (najbolje 

funkcionira s jednostavnim oblicima), Classic Tween, koji služi za stvaranje pokreta pomicanjem 

simbola ili rotiranjem, i Motion Tween, s kojim se može animirati pokret, promjena veličine i 

rotacija. 

4.3.1. Animiranje s Classic Tween-om 

Classic Tween-om animirana je ptica koja maše krilima i kreće se na sceni. 

 

S obzirom na to da se svaki element ptice nalazi na drugom sloju, potrebno je povezati te 

slojeve kako bi se kretali zajedno. To se može postići kreiranjem odnosa roditelj-dijete (eng. 

parent-child) između slojeva (Slika 91). 

 

 

Slika 91 Adobe Animate - Parenting 
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Roditelj djetetu se određuje klikom na Parenting view (Slika 91) i odabirom elementa s popisa. 

U ovom slučaju, tijelo ptice je roditelj, i kada se ono transformira, sva djeca ga prate. Djeca se 

mogu odvojeno transformirati bez roditelja, ali roditelj se ne može odvojeno bez djece. 

 

Classic Tween na tijelu ptice možete kreirati desnim klikom na sloju u Timelinu i odabirom 

opcije Create Classic Tween, ali prvo je objekt potrebno pretvoriti u simbol. Sloj na kojem je 

Classic Tween postaje ljubičast (Slika 92). 

 

 

Slika 92 Adobe Animate - Classic Tween Timeline 

 

Početni i završni položaj u animaciji određuju se Keyframe-ovima (Slika 93), a program 

automatski popunjava kadrove između njih kako bi radnja izgledala glatko. 

 

 

Slika 93 Adobe Animate - Početak i kraj leta 

 

Svaki element ptice moguće je zasebno animirati unutar simbola. Unutar simbola je animirana 

radnja mahanja krilima na isti način kao i u običnom Timeline-u (Slika 94). Kada je radnja 

animirana unutar simbola, automatski se ponavlja onoliko dugo koliko traje animacija. Kada ptica 

sleti, više nema potrebe za mahanjem krilima, i ta radnja se može zaustaviti. Na mjestu gdje se 

animacija simbola želi zaustaviti, potrebno je stvoriti Keyframe i u Properties panelu objekta 

odabrati Play a single frame or for the graphic (Slika 95). 
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Slika 94 Adobe Animate -  Animiranje unutar simbola 

 

 

Slika 95 Adobe Animate -  Looping 
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4.4. Rendering 

Postoji više opcija za generiranje konačne animacije u Adobe Animate-u. U gornjem desnom 

kutu alatne trake programa nalazi se gumb Quick Share and Publish s kojim je moguće renderirati 

video ili GIF animacije, ali se ne može utjecati na dodatne postavke renderiranja (Slika 96). 

 

 

Slika 96 Adobe Animate - Quick share and publish 

 

Postavke renderiranja moguće je urediti odlaskom na File -> Publish Settings (Slika 97).  

 

 

Slika 97 Adobe Animate - Publish Settings 

 

Gumb Publish pokreće renderiranje animacije prema zadanim postavkama (Slika 97). 
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5. Usporedba OpenToonz i Adobe Animate programa 

U suštini, oba programa imaju istu svrhu: kreiranje 2D animacije. OpenToonz podržava rad s 

rasterom i vektorom. Više je usmjeren na izradu 2D animacije nacrtane ručno i omogućava 

skeniranje crteža s papira. Također, ima veliki izbor rasterskih i vektorskih kistova koji se mogu 

koristiti s grafičkim tabletom. Uz razne kistove ima i razne opcije za bojanje i mnogo paleta. Stilovi 

su velika ušteda vremena jer izmjene automatski odražavaju na sve kadrove. S druge strane, u 

Adobe Animate-u moguće je izraditi samo vektorske elemente. Kistovi su jednostavni i 

omogućuju kreiranje samo vektorskih linija. Ali, pomoću Adobe Animate-a moguće je kreirati 

interaktivan 2D sadržaj i dijeliti ga na raznim platformama. Animacije se mogu objavljivati u 

formatima HTML5, WebGL, skalabilne vektorske grafike (SVG) i Adobe Integrated Runtime 

(AIR). Često se koristi za izradu info grafike, prezentacija i reklama. Njegova prednost je 

automatsko usklađivanje položaja usta s infleksijama glasa i može izvesti 360 VR animacije. U 

oba programa se mogu dodavati multimedijski sadržaji kao što su slika, zvuk i video. 

 

Samo sučelje OpenToonz-a nije toliko intuitivno i može biti pretrpano prozorima. Podijeljen 

je na sobe koje imaju posebne uloge što može biti zbunjujuće. Adobe Animate ima jednostavnije, 

modernije i organiziranije sučelje. Timeline je u oba programa sličan i koristi se na sličan način. 

Bitno je napomenuti da Adobe Animate omogućuje povezivanje slojeva u hijerarhiji roditelj-

dijete, što znatno olakšava animiranje kada je svaki element na posebnom sloju. Oba programa 

nude korisnu opciju Onion skin, za crtanje uzastopnih kadrova. 

 

Oba programa nude slične osnovne alate za selektiranje, pomicanje, transformaciju, crtanje, 

brisanje itd. i oba programa nude alate za kreiranje kostura i modificiranje objekata koristeći mrežu 

koji su jako korisni za izradu animacije. Pošto OpenToonz radi s rasterom i vektorom, njegovi 

alati imaju više opcija nego alati u Adobe Animate-u. 

 

Također, u oba programa je moguće kreirati pokret crtanjem svakog kadra ili korištenjem 

Keyframe-ova između kojih program automatski generira međuslojeve. Rad sa simbolima u 

Adobe Animate-u dodatno olakšava animiranje jer omogućuje kreiranje animacije unutar 

animacije. 

 

OpenToonz ima veliki izbor efekata koji se mogu dodati elementima, a u Adobe Animate-u 

možete skratiti vrijeme animiranja koristeći njegovu knjižnicu animiranih i statičnih likova i 

objekata. 
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Velika razlika između ova dva programa, a možda i ključna je njihova cijena. OpenToonz je 

potpuno besplatan i otvorenog koda, dok se Adobe Animate mora plaćati na mjesečnoj bazi. Ova 

prednost OpenToonz-a možda je istovremeno i mana jer je program sklon "rušenju" i može se 

dogoditi da program ne radi kako treba ili da neki alat ne radi kako bi trebao, a pošto je otvorenog 

koda, ne postoji korisnička podrška. 
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6. Zaključak 

Animacija predstavlja umjetnost iluzije pokreta putem niza statičnih slika i ima dugu povijest 

koja seže do prapovijesnih prikaza lova na špiljskim zidovima. Razvoj animacije doživio je 

značajne prekretnice, uključujući pojavu Disneyjevog prvog dugometražnog filma, "Snjeguljica i 

sedam patuljaka", te kasnije uspon računalne animacije, posebno naglašen kroz film "Priča o 

igračkama". 

 

Danas se računalna animacija oslanja na tehnološke alate za ubrzanje procesa, zamjenjujući 

tradicionalne listove papira i cel folije digitalnim datotekama. Animatori koriste softverske 

programe za crtanje, primjenjuju različite efekte, uključuju zvuk i glazbu te stvaraju animacije u 

video formatu. 

 

Postoji mnogo programa za izradu 2D animacije, uključujući besplatne i komercijalne opcije. 

U ovom radu uspoređena su dva takva alata, OpenToonz i Adobe Animate, koji nude različite 

pristupe izradi 2D animacije. Dok OpenToonz podržava rad s rasterom i vektorom te pruža mnoge 

opcije za ručno crtanje i efekte, Adobe Animate se ističe svojom sposobnošću stvaranja 

interaktivnog sadržaja i izvoza u različite formate, uključujući HTML5 i WebGL. 

 

U konačnici, odabir između OpenToonz-a i Adobe Animate-a ovisi o specifičnim potrebama i 

preferencijama korisnika u izradi 2D animacije. 
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